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ВВЕДЕНИЕ 

 

Центральной  проблемой  современного  экологического  мониторинга 

является  получение  объективной  информации  об  окружающей  среде.      

Перспективным  методом  исследования  поверхности  нашей  планеты  

и  ее  атмосферы является применение искусственных спутников Земли. 

Особенно это важно для бескрайних просторов Сибири, где расположены 

основные запасы полезных ископаемых, основные лесные ресурсы, крупные 

промышленные и гидротехнические комплексы, но низка плотность 

населения. Интерес к космическим методам мониторинга возрос в последние 

годы в связи со свертыванием наземных и авиационных средств контроля 

окружающей среды, с одной стороны, и ростом доступности космической 

информации, с другой [1].  

В последние десятилетия все шире применяется цифровая обработка 

спутниковых изображений. Компьютерные обеспечения, информационные 

технологии  позволяют преобразовывать спутниковые изображения, 

устранять их искажения и даже «делать невидимое видимым» [1].  

В настоящее время современные технологии позволяют рассматривать 

не только моря и океаны, но и такие маловодные объекты как реки или озёра. 

И сейчас различные электронные ресурсы позволяют без затруднительно и 

бесплатно скачать снимки, сделанные из космоса, любой территории, 

предоставляя пользователю большой выбор спутников с разным 

разрешением, уровнем обработки и точностью позиционирования. 

В малых водоёмах протекает множество различных биологических и 

химических процессов, которые могут вилять на температуру и показатель 

мутности воды, а так же на другие различные параметры.   

Цель дипломной работы: изучение информационной технология 

мониторинга динамических процессов малых водных объектов по 

спутниковым данным (на примере оз. Шира). 

Задачи дипломной работы: 
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- формирование банка данных спутниковых изображений LANDSAT8 

озера Шира за летний период 2014, 2015 гг; 

- обработка спутниковых изображений с использованием программных 

средств; 

- определение интервальных значений RGB модели для определения 

интервала контрастирования; 

-фопределение интервальных значений Нормированного 

относительного индекса мутности (NDTI) и пространственное распределение 

температуры на поверхности воды для определения интервала 

контрастирования; 

- изучение и применение технологии извлечения параметрической  

информации при помощи пакета ENVI(на примере озера Шира); 

- провести анализ полученных данных пространственного 

распределения температуры на поверхности воды и нормированного 

разностного индекса мутности; 

- расчет градиентных полей для визуализации динамики показателей, 

которые необходимы для получения границ существующих природных 

эффектов переноса взвеси, тепла, хлорофилла. 
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1 Описание проблемной области 

 

1.1 Описание объекта 

 

В качестве водного объекта, с точки зрения изучения 

функционирования экосистемы, может являться озеро Шира (Хакасия). Это 

связано с тем, что этот малый водный объект существенно схож по химико-

биологической структуре с крупным, каким является Черное море [2]. 

Шира - озеро в Ширинском районе Республики Хакасия. Расположено 

в неглубокой горной впадине, в 340 км от Красноярска, в 160 км от 

г. Абакана, до ст. Шира около 12 км. В 3 км от озера находится пресноводное 

озеро Иткуль, а в 8 км от озера находится самый крупный минеральный 

водоём Хакасии - озеро Белё[2]. 

Водное зеркало озера протянулось на 9,5 км при наибольшей ширине 

5 км, максимальная глубина озера - 24 м, площадь - 35 км². Берега Шира 

безлесные и только в западной части встречаются небольшие березовые 

колки. Дно озера уступами поднимается к пологим берегам, покрытым слоем 

песка и образующим удобные пляжи [2]. 

Шира - слабосолёное озеро, несмотря на то, что в него с восточной 

стороны впадает небольшая река Сон. Поэтому здесь берег озера 

представляет собой болотистую низину. По составу озерная вода 

слабощелочная, сульфатно-хлоридная, натриево-калиевая, с повышенным 

содержанием магния. Содержание солей в воде на протяжении всего озера 

неодинаково, наиболее высокое в центральной части [2]. 

Наиболее удобными для анализа спутниковых данных параметрами 

являются мутность и температура поверхности воды. 
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1.2 Мутность воды 

 

Мутность может быть определена как облачность воды или помехи в 

прохождении света, вызванные взвешенными материалами.  Чем больше 

количество всех взвешенных твердых частиц в воде, тем выше измеренная 

мутность. Причины мутности включают эрозию почвы, сброс отходов, 

городских стоков, и рост водорослей. Дистанционное зондирование получает 

оптическую меру мутности воды. Дистанционное зондирование изображения 

со спутника имеет потенциал, чтобы обеспечить важную информацию, 

предложить значительные преимущества для изучения больших областей, 

определение мониторинга осаждения, продуктивности воды и эвтрофикации 

[3]. 

Нормализованный разностный индекс мутности(Normalised Difference 

Turbidity Index -NDTI) классифицируют на 3 класса: низкий, умеренный и 

высокий. Мутность включает в себя грязь, осадок, чрезмерный рост 

водорослей, фитопланктона, глины и ила. Мутность может быть вызвана 

стоком земель, загрязнением, эрозии береговой линии, и 

ресуспендированием донных отложений. Прозрачность воды и мутность 

оказывают существенное влияние на нашу экосистему. Мутность состоит из 

неорганических и органических компонентов, которые могут содержать 

высокие концентрации вирусов, простейших и бактерий [3].  

Традиционно, мониторинг качества воды озер располагается на 

стационарных постах, сбор проб воды и анализ в лаборатории. Этот метод 

был утомительным, трудоемким и дорогостоящим. Проблемы выбора точки 

на стационарных постах можно преодолеть за счет использования 

спутниковых снимков, которые потенциально предложат широкий охват 

области, а также долгосрочное и непрерывное измерение качества воды. 

Факторы, которые заставили людей перейти к спутниковому наблюдению за 

качеством воды является технико-экономическое обоснование, стоимость и 

значение информационного содержания. Дистанционное зондирование 
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может использоваться для получения качественной или количественной 

оценки мутности воды.  Интеграция дистанционного зондирования с 

данными по выборке места, приводит к созданию динамических карт 

различных параметров качества воды, включая мутность и облегчает 

исследование. Дистанционное зондирование также может быть использовано 

для мониторинга взвешенных минеральных концентраций в водоемах. 

Мутность в основном вызвана взвешенными наносами в поверхностных 

водах. Наносы являются важным экологическим параметром, используемым 

при определении качества воды. Коэффициент пропускания в видимом 

диапазоне длин волн для природной воды снижается, а уровень мутности 

воды значительно увеличивается. Длины волн между 600-800 нм наиболее 

полезны для определения взвешенных наносов в поверхностных водах. 

Оптимальная длина волны для количественной оценки концентрации 

взвешенных наносов 600-650 нм. Нормализованный индекс мутности 

определяется связью между взвешенными наносами и отрицательной 

радиацией и рассчитывается для видимого диапазона  зеленой/красной части 

длины волн  (формула 1) [3]. 

 

NDTI= 
 кр.− зел.

 кр.+  зел.
   ,                                                                                  (1) 

 

где:  кр,  зел – красная и зелёная часть длины волны 

Для определения мутности, произведена маска земли, для того чтобы 

была проанализирована только водная поверхность. Пиксельные значения, 

соответствующие земле были установлены в 0 в результате функции 

маскирования. 

С ростом осведомленности в области борьбы с загрязнением воды и 

желанием поддерживать озера на своих высоких уровнях качества, 

ожидается, что подход, описанный в работе, окажется полезным 

инструментом в оценке качества воды, который будет выгодно 
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использоваться. Преимущества дистанционного зондирования для оценки 

качества воды в озерах составляет: 

Дистанционное зондирование позволяет собирать данные из 

труднодоступных районов. 

Возможные измеряемые наблюдения помогают приобрести 

количественные и качественные данные. 

Данные могут быть постоянно записаны и воспроизведены в любое 

время. 

Дистанционное зондирование также заменяет дорогостоящий и 

медленный сбор данных на месте. 

Большая часть информации получается в очень короткое время. 

Динамическое измерение помогает в изменении мониторинга. 

 

1.3 Температура поверхности воды 

 

Температура поверхности воды является одним из косвенных 

показателей динамики водоемов, а также тесно связана с 

функционированием экосистемы. Информация о пространственно-

временном распределении температуры поверхности температуры воды 

необходима для оценки накопления и расходования тепла водной массой в 

результате ее теплообмена с атмосферой и ложем озера, расчета теплового 

баланса, разработки методов прогноза сроков вскрытия и замерзания 

водоема. Температура воды является важнейшим параметром, позволяющим 

выявить климатические изменения. В связи с этим постоянный мониторинг и 

оперативное картографирование температуры поверхности воды необходимы 

при изучении глобального и локального изменения климата [3]. 

Температура поверхности воды может использоваться для наблюдения 

за глубинными разломами, так как они являются зонами повышенной 

проницаемости земной коры и служат проводящими путями растворов и 

газов, как правило, более высокотемпературных по сравнению с 
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поверхностью дна озера, что приводит к уникальным современным явлениям 

и процессам, в том числе появлению аномалий в распределении температуры 

поверхности воды [4]. 

Температура поверхности воды является важной характеристикой 

состояния экосистемы озера. Она характеризует сезонные изменения 

состояния стратификации водной толщи. Дважды в год, в периоды весенней 

и осенней конвекции, она близка к температуре перемешанного слоя 

толщиной до 150 м. Пространственно-временные изменения температуры 

воды являются также одним из важнейших показателей биологической 

продуктивности акватории, на которую она оказывает как прямое, так и 

косвенное влияние. Температура воды определяет условия местообитания 

озерной флоры и фауны. Также температура воды является одним из 

определяющих параметров газообмена между водной средой и атмосферой 

[4]. 

Кроме этого температура играет значительную роль в возникновении  и 

поддержании циркуляции и перемешивания в озере. По картам 

распределения температуры поверхности воды можно косвенно 

анализировать такие динамические явления, как течения, апвеллинг, 

перераспределение речных вод, термический барьер (термобар), вихревые 

структуры и др. [4]. 

Для изучения многих лимнологических процессов и понимания 

озерной гидродинамики полезно иметь систематические данные о 

пространственно-временном распределении температуры поверхности за 

продолжительный период времени, которые стали доступны с развитием 

дистанционных спутниковых средств мониторинга состояния поверхности 

Землих [4]. 

Для нахождения температуры при помощи модуля IDL, в коде 

программы используется формула 2. 
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 T = 
𝐾2

𝑙𝑛
𝐾1

𝑅𝑀∗𝑑𝑎𝑡𝑎+𝑅𝐴)
+1

     ,                                                                          (2) 

 

где: RM, RA (Radiance Multiplier и Radiance Add), K1, K2 - коэффициенты для 

расчета  температуры воды; 

       T – температура в Кельвинах; 

       data – данные 10-го или 11-го каналов Landsat [4]. 

Калибровочные коэффициенты для 10 и 11 канала Landsat, 

представлены в таблице 1. 

 

Таблица 1- Калибровочные коэффициенты для 10 и 11-канала 

 Band 10 Band 11 

Radiance Multiplier 0.0003342 0.0003342 

Radiance Add 0.1 0.1 

K1 774.89 480.89 

K2 1321.08 1201.14 

 

1.4 Расчёт градиента полей 

 

Градиент – вектор, своим направлением указывающий направление 

наибольшего возрастания некоторой величины, значение которой меняется 

от одной точки пространства к другой (скалярного поля), а по величине 

(модулю) равный быстроте роста этой величины в этом направлении [5] 

Расчет градиентов необходим, чтобы использовать в математических 

моделях, где этот расчет осуществляется для определения формирования 

мест с большим или меньшим количества вещества, энергии. 

Что касается малоразмерных водоемов, здесь именно расчет характеристик 

спутниковой информации дает возможность оценить динамику. процесса 

физического и биологического. 
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Математическая модель позволяет формализовать географическое 

представление на основе создания логико-математических конструкций, 

отражающих количественные отношения реальных географических объектов 

[6], а также позволяет выполнять различные функции: 

- возможность изучения тех объектов и явлений, которые чрезвычайно 

трудно исследовать иными методами; 

- определение необходимой информации, ее сбор и систематизация; 

- выявление и объяснение механизма развития конкретного явления [6]. 

Градиента полученных изображений рассчитывался путём вычисления 

корня из суммы квадратов изменения конкретной величины по осям x и y 

(формула 3): 

 

               (3) 

 

Для расчёта данной формулы был написан код на языке 

программирования IDL, в котором сначала находились минимальные и 

максимальные значения индексов в изображении. Это делалось для того, 

чтобы правильно сформировать условие выборки ячеек, для которых будет 

рассчитываться градиент. 

 

2 Использующееся программное обеспечение и данные 

 

2.1 Описание пакета ENVI 

 

Пакет ENVI (EnvironmentforVisualizingImages — среда для 

отображения снимков) программное обеспечение для работы с данными 

дистанционного зондирования [7].  
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Среда Envi содержит полный пакет необходимых инструментов и 

функций для визуализации, анализа и презентации цифровых изображений. 

ENVI включает в себя функции: 

- по обработке и глубокому анализу гиперспектральных снимков; 

- по исправлению геометрических и радиометрических искажений; 

- поддержки объемных растровых и векторных форматов; 

- по интерактивному улучшению изображений; 

- по интерактивному дешифрированию и классификации; 

- по анализу снимков в радиодиапазоне; 

- построения запросов; 

- оцифровки. 

В  ENVI встроен удобный язык программирования IDL 

(InteractiveDataLanguage), так что возможно расширить функциональные 

возможности ENVI или создать собственные подпрограммы [7]. 

Открытая архитектура ENVI обеспечивает удобство обработки данных, 

полученных со спутников Landsat, SPOT, RADARSAT, NASA, NIMA, NOAA, 

EROS DataCenter, SpaceImaging, Terra, ESA, а также предусматривается 

включение в этот список EartWatch и ORBIMAGE и других спутников [7]. 

ENVI позволяет отображать графические данные удобно и в любом 

разрешении. Возможна работа с миниатюрами (размер которой, также можно 

изменять), изображениями в максимальном разрешении, использовать 

увеличение/уменьшение или пользоваться всем этим одновременно [7]. 

Широкие возможности индивидуальной настройки интерфейса.  

Инструменты спектрального анализа ENVI позволят максимально 

эффективно работать с мульти/гиперспектральными снимками. 

Идентифицировать материалы по спектру и обозначать их 

распределение на снимке. Определять материалы по характеристикам, даже в 

случае, когда их площади меньше площади одного пиксела. Определять 

композицию любых неизвестных спектральных характеристик численным 
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сравнением с библиотекой спектров материалов - произвольно заданной, 

либо поставляемой в составе ENVI [7].  

Помимо передового инструментария для гиперспектрального анализа, 

ENVI включает и полный набор инструментов для традиционного анализа 

изображений. 

ENVI включает все основные функции, такие как регистрация, 

калибровка, математические операции с зонами, классификация, улучшение 

контраста, фильтрация, трансформация компонентов, определение 

коэффициентов зональности, индекс вегетации, выделение границ, 

увеличение резкости изображения, пакетная обработка, составление карт на 

основе отдельных слоев и объектов и многое другое. 

 

2.2 Спутниковые снимки Landsat-8 

 

Американский спутник дистанционного зондирования Земли, восьмой 

в рамках программы Landsat (седьмой выведенный на орбиту). Изначально 

назывался Landsat Data Continuity Mission (LDCM), создан совместно NASA 

и USGS. Выведен на орбиту 11 февраля 2013 года [8]. На таблице 2 показаны 

характеристики спектральных каналов спутника. 

 

Таблица 2 – Спектральные каналы спутника Landsat-8 

Спектральный канал Длины волн, мкм Пространственное 

разрешение, м 

Канал 1 — Побережья и 

аэрозоли (Coastal / Aerosol, 

New Deep Blue) 

0.433 — 0.453  30  

Канал 2 — Синий (Blue) 0.450 — 0.515  30  

Канал 3 — Зелёный (Green) 0.525 — 0.600  30  

Канал 4 — Красный (Red) 0.630 — 0.680  30  
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Окончание таблицы 2 

Канал 6 — Ближний ИК 

(Short Wavelength Infrared, 

SWIR 2) 

1.560 — 1.660  30  

Канал 7 — Ближний ИК 

(Short Wavelength Infrared, 

SWIR 3) 

2.100 — 2.300  30  

Канал 8 — 

Панхроматический 

(Panchromatic, PAN) 

0.500 — 0.680  30  

Канал 9 — Перистые облака 

(Cirrus, SWIR) 

 

1.360 — 1.390  30 

 

2.3 Сервисный центр для получения спутниковых изображений 

(EarthExplorer) 

 

Сервис EarthExplorer - это сервис USGS, через который осуществляется 

получение самих данных. Регистрация бесплатная, без регистрации получить 

отобранные данные будет невозможно (http://earthexplorer.usgs.gov). 

На главной странице сервисного центра выделяем нужную территорию 

и допустимую облачность. Для того чтобы перейти в нужное место можно: 

щелкнуть по карте-локатору в верхнем-левом углу, передвинуть карту с 

помощью стрелок и мыши. Одинарными кликами по поверхности задать 

полигон. 

Для поиска снимков нужно нажать кнопку DataSets и выбрать спутник. 

После выбора спутника, нажатием кнопки Results выводится список 

результатов-снимков за разные промежутки времени. Поиск проводился по 

спутникам Landsat-8 за лето 2014-2015 года. Формат снимков- GeoTIFF. 
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Неудобство данного сервиса в невозможном скачивании более трёх архивов 

одновременно. 

 

2.4 Исходные данные 

 

Выбраны те спутниковые снимки, которые менее всего подлежат 

коррекции.  Полученные снимки спутника Landsat-8 из Автоматизированной 

Системы Приема Хранения и Визуализации Космоснимков представлены в 

таблице 3. Используются только 4-й (рисунок 1), 2-й и 3-й каналы для 

формирования RGB изображения. 

 

Таблица 3 – Данные по снимкам, полученных со спутника Landsat-8 

Канал ID снимка Сенсор Спек. 

Канал 

Разрешение

, м 

Дата 

снимк

а 

Красный 

(R) 

LC81430222015

198LGN00_B4 

OLI/TIRS М 30 2015-

07-17 

Зелёный 

(G) 

LC81430222015

198LGN00_B3 

OLI/TIRS М 30 2015-

07-17 

Синий 

(B) 

LC81430222015

198LGN00_B2 

OLI/TIRS М 30 2015-

07-17 
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Рисунок 1 – Изображение оз.Шира, полученное со спутника Landsat-8 

LC81430222015198LGN00_B4 

 

2.5 Маска облаков 

 

Наличие облаков и падающей от них тени делают анализ данных 

водной поверхности более трудной задачей, так как они искажают 

спектральные характеристики поверхности. Поэтому предварительно 

убранные облака помогают использовать снимки с облачностью, что очень 

увеличивает количество обработанных снимков, для дальнейшего анализа 

параметров воды. 

На рисунке 2 облака перекрывают интересуемую территорию и  

мешают получить необходимые параметры водной поверхности для 

дальнейшей обработки. 
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Рисунок 2 – Фрагмент изображения оз. Шира 

 

Для оценки качества снимков, полученных с Landsat-8, и определения 

точного месторасположения облачности и её удаления, используется канал 

BQA (канал оценки качества). При открытии канала оценки качества при 

помощи ENVI, указаны десятичные значения пикселя для идентификации 

воды, облака, суши. Для поверхности оз. Шира указано значение – 20512. 

Теперь можно отделить воду и сушу от облаков. Для этого, в коде программы 

модуля IDL указываем, что необходимо оставить только ту территорию, для 

которой значения канала оценки качества равны 20512. Дальше нужно 

записать и сохранить в файл геоинформацию снимка, координаты, проекцию. 

Для этого прописываем в коде GEOTIFF=geotag.  
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2.6 Обработка изображений, полученных со спутника Landsat 8 

 

При подготовке спутниковых данных возникает задача их обработки, 

для выделения каких-либо объектов (например, очагов пожаров). В таком 

случае, с полученными изображениями на этом этапе необходимо провести 

различные преобразования (с использованием различных графических 

фильтров и других способов). 

Выполним алгоритм обработки спутниковых изображений на примере 

снимка, полученного со спутника Landsat 8 за 14 июля 2014 г.  

Обработку изображений осуществляем с помощью программного 

обеспечения ENVI 4.7. Используем следующие спектральные каналы: 4,3,2. 

Составляя комбинацию из спектральных каналов снимка со спутника 

Landsat-8, получаем RGB изображение объекта (оз. Шира) (рисунок 3). 

 

 

Рисунок 3 - RGB-модель снимка, полученного со спутника Landsat-8 

(14.07.2014) 
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Сохраняем полученное изображение в формат TIFF/geoTIFF. Для это в 

меню ENVI выбираем File -> Save file as -> TIFF/geoTIFF. 

Дальше необходимо выделить интересующую нас территорию. Для это 

на панели окна Screen выбираем Tools ->  Cursor Location/Value. Открывается 

окно (рисунок 4) на котором мы видим подробную информацию о пикселе, 

на который наведён курсор. 

 

 

 

Рисунок 4 – Инструмент программного пакета ENVI для определения данных 

о конкретной ячейке Cursor Location/Value  

 

Выбираем нужную территорию. В нашем случае, интересуемый объект 

находится между пикселями с координатами (1215;3791) и (1615;4188). Для 

того, чтобы обрезать изображение опять в меню ENVI выбираем File -> Save 

file as -> TIFF/geoTIFF. В появившемся окне выбираем Sputial Subset и 

вводим в новом окне координаты пикселей. Получаем RGB-модель снимка с 

интересующей нас территорией (Рисунок 5). 
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Рисунок 5- RGB-модель снимка, полученного со спутника Landsat-8 

(14.07.2014) 
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2.7 Контрастирование снимков 

 

Построение гистограмм показывает преобразования, улучшающие 

репрезентативные свойства изображений. Контраст изображения - это 

разность между максимальным и минимальным значениями яркости.  

Слабый контраст – наиболее распространенный дефект изображений. При 

линейном растяжении гистограммы всем значениям яркости присваиваются 

новые значения с целью - охватить весь возможный интервал изменения 

яркости от 0 до 255 [9].   

Гистограмма - это график статистического распределения элементов 

цифрового изображения с различной яркостью, в котором по горизонтальной 

оси представлена яркость, а по вертикали — относительное число пикселов с 

конкретным значением яркости [9]. 

Изучив гистограмму, можно получить общее представление о 

контрасте и цветовом насыщении снимка, оценить требуемую коррекцию 

при последующей обработке [9]. 

Выполним контрастирование на примере красного канала (Рисунок 1). 

Контрастирование: открываем в ENVI изображение 

LC81430222015198LGN00_B4 (рисунок 1). Для доступа к функциям 

растяжения контраста в меню группы дисплеев выбираем Enhance-

>Interactive Stretching. С помощью Cursor Location/Value мы можем 

определить минимальное и максимальное значение пикселей в нужной 

области. Для данного снимка минимальное значение – 6422; максимальное 

значение - 6929 

Сравнение двух изображений свидетельствует о значительно лучшем 

визуальном качестве обработанного изображения. Улучшение связано с 

представлением изображения после контрастирования в полном 

динамическом диапазоне сигнала (рисунок 6). 
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Рисунок 6 – Изображение оз. Шира, полученное со спутника Landsat-8 

LC81430222015198LGN00_B4 (14.07.2014) 
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Далее выполняем растяжение гистограммы (рисунок 7) для того, чтобы 

исключить сушу вокруг интересуемой нами территории. Для этого 

переходим во вкладку Enhance->Interactive Stretching. В появившемся окне 

заходим в Options->Histogram Parameters. Устанавливаем минимальное и 

максимальное значение. Гистограмма в интервале от наименьшего значения 

величины - 6422 до наибольшего значения величины - 6929. 

 

 

Рисунок 7 - Линейное растяжение гистограммы изображения до 

динамического диапазона отображения (Landsat-8 

LC81430222015198LGN00_B4) (17.07.2015) 

 

На рисунке  8 отсутствует участок суши, путем не включения его в 

диапазон значений яркости. 
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Рисунок 8 – Изображение оз.Шира, полученное со спутника Landsat-8 

LC81430222015198LGN00_B4 после растяжения гистограммы 

(14.07.2014) 

 

Дальше, для получения необходимого изображения, нужно отработать 

этот принцип на G-канале и B-канале, а также с 10-м каналом спутника 

Landsat-8. Результатом работы получаем RGB (4:3:2) изображение с 

растянутой гистограммой по каждому каналу (рисунок 9). 
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Рисунок 9 – Изображение оз.Шира, после растяжения гистограмм по 

каждому каналу RGB (4:3:2) (14.07.2014) 

 

Проделав данный алгоритм обработки спутниковых изображений, была 

сформирован банк данных, который теперь можно использовать для рассчёта 
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индекса мутности и пространственного распределения температуры на 

поверхность воды. 

 

3 Алгоритм расчёта индексов 

 

3.1 Основные функции IDL, использованные в программе 

 

В этом разделе описываются основные функции IDL, которые были 

использованы в данном приложении. В IDL имеются условные операторы, 

позволяющие выбрать один из двух или более вариантов выполнения 

требуемого фрагмента программы. 

Иными словами, если после THEN следует единственное выражение, 

то всё условное утверждение, начиная с IF… может быть записано в одну 

строку (в случае необходимости — с переносами). Если же после THEN 

следует несколько утверждений, то они заключаются в операторные скобки 

(begin, end). Закрывающая операторная скобка может иметь вид END или 

ENDIF, это безразлично; однако если условное выражение достаточно 

разветвленное, то использование формы ENDIF позволяет избежать 

неоднозначности в интерпретации последовательности вложенных условных 

выражений. Слово ENDIF пишется без пробелов [10]. 

Так же в IDL присутствуют циклы, для последовательного выполнения 

одного и того же действия, например применения математических и других 

операторов к каждому элементу массива [10]. 

Так же в IDL есть функции для чтения и записи данных в различных 

форматах. Например, таких как geotif. 

Функция READ_TIFF считывает одно или многоканальные 

изображения из файлов формата TIFF и возвращает изображение и цветовые 

таблицы векторов в виде IDL переменных. 

Результат = READ_TIFF (Имя файла, различные ключевые слова. 



27 

 

Процедура WRITE_TIFF можете записать TIFF файлы с одним или 

несколькими каналами, где каждый канал может содержать 1, 4, 8, 16, или 

32-разрядное целочисленное значение пикселя, или значения с плавающей 

запятой. 

WRITE_TIFF, имя файла, массив данных, различные ключевые слова. 

  

3.2 Расчёт индексов 

 

Для получения температуры поверхности воды и удаления облаков и 

суши, использовался язык программирования IDL. 

На рисунке 10 показана блок-схема расчёта пространственного 

распределения температуры поверхности воды без облаков, на примере 

спутника Landsat-8. И аналогично температуре воды, на рисунке 11 

изображена блок-схема расчёта индекса мутности воды, без облаков и суши, 

на примере спутника Landsat-8. 

При расчёте индекса мутности было выявлена проблема, которая 

заключается в том, что IDL нестабильно работает с операцией деления. Для 

решения данной проблемы пришлось отдельно рассчитывать делимое и 

делитель и уже на новой строке считать их частное. 

На рисунке 12 показано пространственное распределение температуры 

поверхности воды оз. Шира  без облаков, на примере спутника Landsat-8. И 

аналогично получению температуры воды, получаем индекс мутности воды, 

без облаков и суши, на примере спутника Landsat-8  (рисунок 13).    
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Рисунок 10 – Блок-схема расчёта пространственного распределения 

температуры 
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Рисунок 11 – Блок-схема расчёта индекса мутности воды 
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Рисунок 12 – Пространственное распределение температуры поверхности 

воды оз. Шира  без облаков 
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Рисунок 13 – Индекс мутности воды оз. Шира  без облаков 

 

Получены индексированные изображения, где каждой ячейке 

соответсвует определённое значение NDTI или температуры поверхности 

воды. В таком виде данные трудно воспринимаются на глаз. Поэтому 

необходимо визуализировать эти изображения. 
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3.3 Визуализация данных 

 

Для более наглядной визуализации полученных данных использовалась 

функция, встроенная в ENVI, ENVI Color Tables. Для её реализации в окне с 

изображением нажимаем Tools -> Color Mapping -> ENVI Color Tables. Для 

визуализации был выбран пункт Rainbow. 

В результате преобразования получились изображения изображенные 

на рисунке 14 и 15. 

 

Рисунок 14 – Результат преобразования изображения распределения 

температуры на поверхности воды 
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Рисунок 15 – Результат преобразования изображения распределения 

индекса мутности на поверхности воды 

 

Полученные значения температуры и мутности в дальнейшем 

возможно совмещать с измеренными данными непосредственно в воде, с 

помощью данных, полученных от научного стационара Института биофизики 

СО РАН на берегу озера Шира. 
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В таблице 4 представлены данные NDTI и температуры, полученные 

после преобразования всех изображений. 

 

Таблица 4 – Параметрические данные изображений 

Дата Минимальное 

значение 

NDTI 

Максимальное 

значение 

NDTI 

Минимальное 

значение 

температуры 

Максимальное 

значение 

температуры 

28.07.2014 -0.111 -0.1 292 295.984 

14.07.2014 -0.108 -0.096 292.2 294 

21.07.2014 -0.105 -0.91 291 294.486 

16.08.2014 -0.093 -0.082 289.788 293 

31.08.2014 -0.082 -0.072 286.434 288.453 

06.06.2015 -0.09 -0.047 281.06 290.563 

07.01.2015 -0.107 -0.1 293.915 298 

17.07.2015 -0.099 -0.094 291 293.988 

09.03.2015 -0.089 -0.081 289.847 291 

19.09.2015 -0.076 -0.067 281.7 283.5 

 

4 Анализ полученных данных 

 

Для анализа полученных данных пространственного распределения 

температуры на поверхности воды и для нормализованного разностного 

индекса мутности для каждой даты были рассчитаны среднее значение для 

всех ячеек, лежащих в области от минимального значения до максимального.  

Так как ячеек со значениями очень много, был написан код на языке 

программирования IDL для расчёта среднего значения для каждого 

изображения. 

Так как значения SUM и N по ходу прохождения по каждой ячейки 

приобретали большие значения, которые IDL приложение не воспринимало, 
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приходилось значения каждой ячейки уменьшать в 1000 раз, а счётчику N 

изначально было присвоено значение -65536. После завершения цикла 

счётчик суммы умножался на 1000, а значению N добавлялось 65536. 

Код представлен в виде блок-схемы на рисунке 16. 

 

Рисунок 16 – Блок-схема для расчёта среднего значения индекса. 
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Ниже представлена таблица 5 полученных значений. 

 

Таблица 5 – средние значения для поверхностного распределения 

температуры и NDTI 

Дата Среднее значение T Среднее значение 

NDTI 

28.07.2014 294,05 -0,107523 

14.07.2014 293,063 -0,102597 

21.07.2014 292,519 -0,0992158 

16.08.2014 291,197 -0,0868574 

31.08.2014 287,224 -0,0760831 

06.06.2015 286,742 -0,0751032 

07.01.2015 295,08 -0,104457 

17.07.2015 292,298 -0,0968122 

09.03.2015 290,244 -0,0848305 

19.09.2015 282,52 -0,0711107 

 

Дальше по полученным значениям были построены графиках (рисунок 

17, 18) на которых видно, что изменения показателей NDTI и температуры 

обратно пропорциональны друг другу. 

 

                            

Рисунок 17 – График распределения средних значений NDTI 
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Рисунок 18 – График распределения средних значений NDTI  

 

Такие показатели обусловлены изменением химических и 

биологических процессов на поверхности воды и количеством взвеси и 

хлорофилла, вызванным ростом нормализованного разностного индекса 

мутности. 

Для выявления границ процессов, протекающих на поверхности воды 

и формирования мест с большим и меньшим веществ, энергии, влияющих на 

эти процессы, рассчитывается градиент полей поверхности воды.  
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Сам код представлен в виде блок-схемы на рисунке 19. 

 

Рисунок 19 – Блок-схема расчёта градиента полей 

 

На риснуках 20, 21 показаны изображения с рассчитанным градиентом 

полей для пространственного расперделения температуры на поверхности 
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воды и для нормализованного разностного индекса мутности и уже с 

применённой функцией ColorMapping. 

 

 

Рисунок 20 – Градиент полей для пространственного распределения 

температуры на поверхности воды 
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Рисунок 21 – Градиент полей для нормализованного разностного индекса 

мутности 
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ЗАКЛЮЧЕНИЕ 

 

В результате проделанной работы была разработана технология 

извлечения параметрических данных из спутниковых изображений. Были 

рассчитаны такие индексы как нормированный относительный индекс 

мутности и пространственное распределение температуры на поверхности 

воды на примере оз. Шира. Данная технология может в дальнейшем 

применяться для любых маловодных объектов. 

Сформированный банк данных можно использовать для дальнейшей 

обработки и вычисление различных индексов помимо NDTI. 

С помощью языка программирования IDL были извлечены 

параметрические данные, произведён их анализ и выявлено, что 

пространственное распределение температуры на поверхность воды обратно 

пропорционально индексу NDTI. 

Полученные изображения были обработаны с помощью специальных 

программных средств для более наглядной визуализации. 

С помощью написанного в IDL кода произведён расчёт градиентных 

полей для визуализации динамики показателей, которые необходимы для 

получения границ существующих природных эффектов переноса взвеси, 

тепла, хлорофилла. 
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ПРИЛОЖЕНИЕ А 

 

Код для расчёта NDTI 

 

pro NDTI 

 

 XX = 8091 

 YY = 8191 

  data_red = fltarr(XX,YY) 

  data_green = fltarr(XX,YY) 

  data = fltarr(XX,YY) 

  data_q = read_tiff('D:\NDTI\LC81430222014179LGN00_BQA.TIF') 

  data_red = read_tiff('D:\NDTI\LC81430222014179LGN00_B4.TIf') 

  data_green = read_tiff('D:\NDTI\LC81430222014179LGN00_B3.TIF') 

      for x=0, XX-1 do begin 

         for y=0, YY-1 do begin 

    data_niz = (data_red[x,y]* 0.0001 + data_green[x,y]* 0.0001) 

    if data_niz ne 0 AND data_q[x,y] eq 20512 then begin 

        data_verx = (data_red[x,y]* 0.0001 - data_green[x,y]* 0.0001)  

        data[x,y] = data_verx/data_niz 

    endif else begin  

        data[x,y] = -9999 

    endelse 

       endfor 

         endfor 

  write_tiff, "D:\NDTI\NDTI_atm.tiff", data, /float 

end 
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ПРИЛОЖЕНИЕ Б 

 

Код для расчёта пространственного распределения температуры 

 

pro temp_shira 

  

 XX = 8091 

 YY = 8191 

  data = fltarr(XX,YY) 

  data1 = fltarr(XX,YY) 

  data2 = fltarr(XX,YY) 

  data_q = read_tiff('C:\try\LC81430222014179LGN00_BQA.TIF') 

  data2 = read_tiff('C:\try\LC81430222014179LGN00_B10.TIf', 

GEOTIFF=geotag) 

  for x=0, XX-1 do begin 

  for y=0, YY-1 do begin 

    if data_q[x,y] eq 20512 then begin 

 

      data1[x,y] = (data2[x,y] * 0.0003342  ) 

      data[x,y] = 1321.08/ALOG((774.89/data1[x,y])+1)  

 

endif else begin  

data[x,y] = 0 

endelse 

  endfor 

  endfor 

   write_tiff, "C:\try\1\temp_atm.tiff", data, /float 

end 
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ПРИЛОЖЕНИЕ В 

 

Код для расчёта средних значений 

 

pro sred_ndti 

  

 XX = 400 

 YY = 397 

 

  data2 = fltarr(XX,YY) 

n = -65536 

sum = 0 

sred=0 

  data2 = read_tiff('C:\DIPLOM\RES\NDTI\TIF\10.TIf') 

min=data2[1,1] 

for y=0, YY-1 do begin 

    for x=0, XX-1 do begin 

    if (min gt data2[x,y]) then begin 

min=data2[x,y] 

endif 

endfor 

endfor 

print, min 

 

max=data2[1,1] 

for y=0, YY-1 do begin 

    for x=0, XX-1 do begin 

    if (data2[x,y] gt max) then begin 

max=data2[x,y] 

endif 
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endfor 

endfor 

print, max 

  for y=0, YY-1 do begin 

    for x=0, XX-1 do begin 

    if (data2[x,y] gt min) and (max gt data2[x,y]) then begin 

    sum = sum+data2[x,y]*0.001  

    n=n+1 

     endif 

   endfor   

  endfor 

     sred=(sum*1000)/(n+65556) 

  print, sred 

end 
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ПРИЛОЖЕНИЕ Г 

 

Код для расчёта градиента полей 

 

pro grad_shira 

  

 XX = 400 

 YY = 397 

 

  data = fltarr(XX-1,YY-1) 

  data2 = fltarr(XX,YY) 

n = -60000 

sum = 0 

sred=0 

data_coord = fltarr(XX-1,YY-1) 

 

  data2 = read_tiff('C:\DIPLOM\RES\NDTI\TIF\7.TIf') 

  data_coord = read_tiff('C:\DIPLOM\111_coord.TIf', GEOTIFF=geotag) 

 

min=data2[1,1] 

for y=0, YY-1 do begin 

    for x=0, XX-1 do begin 

    if (min gt data2[x,y]) then begin 

min=data2[x,y] 

endif 

endfor 

endfor 

print, min 

 

max=data2[1,1] 



49 

 

for y=0, YY-1 do begin 

    for x=0, XX-1 do begin 

    if (data2[x,y] gt max) then begin 

max=data2[x,y] 

endif 

endfor 

endfor 

print, max 

  for y=0, YY-2 do begin 

    for x=0, XX-2 do begin 

 if (data2[x,y] gt min) and (max gt data2[x,y]) then begin 

     data[x,y]=sqrt(((data2[x,y]-data2[x,y+1])^2)+((data2[x,y]-

data2[x+1,y])^2)) 

     endif 

  endfor   

    endfor 

  write_tiff, "C:\DIPLOM\RES\TEMP\GRAD\10.tif", data, /float, 

GEOTIFF=geotag 

 




